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The Digital Audio Analyzer

The DAA is a measuring and testing instrument for sound equipments.

Like  all  the  theremino  system  applications,  the  DAA is  also  a  "portable"  application.  The  "portable"
applications do not require installation and do not modify anything outside the folder in which they are
located. It is therefore possible to copy them from one folder to another or from one computer to another.

With the "portable" applications the operating system is not modified and the installation and uninstallation
operations are simplified.

Install 
Copy "Daa.exe" and the documentation folder “Docs” in any folder. Then start the file "Daa.exe".

 

Uninstall
Delete all the DAA files.
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The Display Commands panel

 SCALE Adjust the brightness of the grid (grid of the display)

 

READOUT Adjust the brightness of a display.
 
 

TRACE Adjust the brightness of the trace on the display.
 

SAMPLES View the samples used by Spectrum, Sweep and Pulse FastSweep

CALIBRATE Make calibration operations

Notes for the SAMPLES command

View the samples on which the analysis of the spectrum is done.

When making "Spectrum" type analysis. "Sweep", "FastSweep" and "Pulse" it is good to press this button
and check the amplitude in volts of the signals that need to be wide as much as possible (act on the
amplifier volume of Outlevel and the system mixer) but which must not reach more than one volt in a
positive or negative with respect to zero. 

If the signals amplitude is low there will be too much noise that will disturb the measurements, if it reaches
the volt signals will be truncated and the measurement will be distorted.

Notes for the CALIBRATE command

The sampling hardware can generate an imbalance of the signal with respect to zero, to highlight:

Press the STEREO button

Ensure that the type is WAVE ANALYSIS

Select channels 1 + 2 on CHANNEL SELECTION OF KEYBOARD

Make sure that the MIXER registration inputs are all zero 

Raising now knob mV / Div of channel 1 up to the maximum of 1 mV (turn the outer part) you will see the
trace move up or down.

Raising the knob mV / Div of channel 2 is highlighted the moving channel 2. The displacement of the track
is due to an imbalance of the converter of the sampling card AD and does not disturb the normal operation
of the card, but, in order to obtain precise measurements, it must be correct.
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Correct the unbalance with “Calibrate”

To make an imbalance correction make sure the keyboard is in the STEREO INPUT, the
ANALYZES OF WAVE is  and that  the MIXER sliders are all  lowered to zero,  press the
CALIBRATE button and wait a few seconds.

During calibration, the LEDs CALIBRATE must quickly flashing red (calibration of channel 1) and then
quickly flash green (channel calibration 2) .

If the LED flashes red only means that the INPUT is MONO and the calibration has been performed only
on channel 1.

If the LED does not blink at all means that there is the input signal (more than 3 mV peak-to-peak, make
sure that the MIXER potentiometers are all set to zero and try again). 

The calibration thus performed is saved on  “DaaMainRegulations.ini”  file and is automatically restored
every time you start the DAA.

The calibration may become inaccurate if you change the registration inputs on the Mixer and can change
over time for the natural aging of the hardware components. 

If  the  TYPE OF  ANALYSIS  is  SWEEP,  FASTSWEEP,  SPECTRUM PULSE or  the  calibration  button
assumes a different function, pressing it makes flat the response curve and then creates a reference on
which to perform comparison measurements, the LED CALIBRATE becomes green and indicates that
there is the reference calibration, by pressing the button again CALIBRATE the LED turns off and the
reference calibration is disabled. If changing FMAX, FMIN, or TIME TYPE ANALYSIS the reference is no
longer valid is then automatically disabled and the LED turns off.
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The Input Output panel

This panel enables and disables the input and output of signals.

INPUT OFF  
Disables sampling (the signal reading). 
 
This command freezes what has been sampled and allows to analyze it for a long time (in this condition the displayed signals
originate from an internal buffer that contains the last 10 seconds sampled).

INPUT MONO 
It enables sampling for the only channel 1 (left). 

The display functions which provide the channel 2 will use it for the channel 1 data. 

INPUT STEREO 
Enables independent sampling on two channels. (CH1 = Left / CH2 = right).

OUTPUT OFF 
Disable the signal generator. 

OUTPUT ON
Enable the signal generator. 

The generated signal is chosen with the WAVEFORM panel and is adjusted in amplitude with SETTING - Outlevel. 
The signal generator is MONO and sends the same signal on channels 1 and 2.
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The CH1 and CH2 panel

This panel is part of the Oscilloscope section and you only use with WAVE BURST and analysis.

The panel is composed by: a Keyboard for channel selections, two knobs mV/Div, two YPos knobs and
two Neg/Pos/Gnd keyboards.

The knobs and keyboards are doubled (left and right) and act on channels 1 and 2.

CHANNEL SELECTION KEYBOARD

CH1 The channel 1.
CH2 The channel 2.
1+2 View channels 1 and 2 simultaneously.
ADD Show only one track which is the sum of channels 1 and 2.
SUB Show only one track which is the difference of channels 1 and 2.
XY The channel 1 in X and channel 2 in Y.

OTHER COMMANDS

YPOS Track Location. 

mV/Div Select the scale in millivolts per division of the display grid. 
The outer ring of twelve places select from 500 mV to 1 mV. 
The potentiometer allows fine adjustment (turning left the value is indicated by the outer  
ring). 
The millivolt per division are also displayed on the display, at the bottom left.

NEG The signal is vertically mirrored (useful for some audio cards).

POS The signal is not vertically mirrored.

GND Display track at zero for a reference. 
In position GND signals are sampled equally, only the display is suppressed.
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The Time Base panel

This panel is part of the Oscilloscope section is only used with the WAVE BURST and analysis.

mS / Div This knob determines the scanning speed. 

The outer ring select twelve places from 500 mS to 0.1 mS. 

The potentiometer allows fine adjustment (turning hard left the actual value It is indicated by
the outer ring). 

The milliseconds per division are also displayed on the display, at the bottom right.

DELAY It works only with INPUT - Off and allows you to move along the display window all the 
buffer sampled signals. 

The zero corresponds to a total rotation in a clockwise direction. 

If the DELAY knob is not zero its value is displayed on the display 
(Bottom in central position) as: Dly xxx mS

DELTA TIME It works only with CHANNEL SELECTION in position 1+2, ADD, SUB and XY. 

Move over time the channel 2 while maintaining the channel 1 fixed. 

The zero corresponds to a total rotation in a clockwise direction. 

If the DELTA TIME knob is not at zero its value is displayed on the display (in low in a 
central position) as: dT xxx mS
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The Meter panel

This panel is part of the Oscilloscope section is only used with the WAVE BURST and analysis.

OFF All measurements are disabled.

CH1 Continuous measurement of the channel 1. 
On the top line of the display shows CH1, the peak-to-peak voltage in volts or in decibel 
(referenced to 2 volts pp) and the cycle time or frequency (only for repetitive waveforms). 
The measurement is independent of any adjustment, the only condition is that INPUT is not 
OFF.

CH2 Continuous measurement of the channel 2. 
On the top line of the display reads CH2, the peak-to-peak voltage in volts or in decibels 
(referenced to 2 volts pp) and the cycle time or frequency (only for repetitive waveforms). 
The measurement is independent of any adjustment, apart from INPUT that must be in 
STEREO.

CURS Enable the sliders to measure the voltage and the time between any two points of the form 
the displayed waveform.

TIME The time measurements are displayed as time.

FREQ The time measurements are displayed as frequency. 
In this condition (using CH1 or CH2 METER always on the panel) is obtained an excellent 
frequency accurate to the tenth of a hertz and able to operate with minimum voltages a few 
millivolts.

VOLT The voltage measurements are displayed in volts peak-to-peak.

dB  The voltage measurements are displayed in decibels referred to two volts peak-to-peak.

CURSOR 1 The CURSOR1 1 knob moves the cursor along the displayed waveform. 
The distance between the two cursors, in voltage and time, is displayed in the upper part of 
the display. When the cursor is to the far left is positioned to zero (which is also referred to
a short section on the left of the display).

CURSOR 2 The cursor2 knob 2 moves the cursor along the displayed waveform. The distance between
the two cursors, in voltage and time, it is displayed in the upper part of the display. When
the cursor is everything to the left is positioned to zero (which is also indicated by a short 
stretch left of the display).
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The Trigger panel

This panel is part of the Oscilloscope section is only used with the WAVE BURST and analysis.

The  trigger  point  is  represented  by  an  arrow on  the  display  pointing  up or  down depending  on  the
condition of SLOPE, which moves to the right and to the left with XPOS and in upward or downward with
LEVEL.

When the INPUT is OFF in the arrow moves down and indicates the zero point of the stored signals of
time.

LED It lights up if the TRIGGER (synchronizer) acts.

OFF The TRIGGER is disabled, and the waveform is presented continuously.

XPOS The knob adjusts the position of the point of TRIGGER from left to right of the display.

LEVEL The knob adjusts the position of the point of TRIGGER in upward or downward with respect
to the zero position of the selected channel for the trigger.

NOISE The knob adjusts the amount of noise tolerated by the TRIGGER (adjust to obtain the 
maximum stability of the waveform).

STAB The knob adjusts the maximum difference between a display and the next (regular 
in order to obtain maximum stability of the waveform).

CH1 The TRIGGER uses the signals from channel 1.

CH2 The TRIGGER uses the signals from channel 2.

SLOPE Select the trigger on the rising edge or on the front of the signal down.

BURST Special operation to synchronize signals consist of pulse packets.
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Special measures

The ANALISIS panels, WAVEFORM, SETTINGS and SPECTRUM, all
located  on  the  right  side  of  the  instrument,  enable  the  special
measurement functions not found in a simple oscilloscope.

Signal generator (WAVEFORM)

It is available a generator of audio signals from 0.1 Hz to 22 KHz with six types of waveform including
white noise and with possibility of burst (pulse packets).

Spectrum analysis (Spectr.)

It allows to analyze a signal by dividing it into various components with respect to the frequency. This
function  can  also  be  displayed  in  three  dimensions  (amplitude,  frequency  and  time)  by  selecting
Spectrum3D from the VIEW menu. The spectrum analysis used with the noise generator  NOISE can
measure the frequency response by canceling the effects of resonance but suffers very randomness of
the noise and does not provide very precise measurements.

type SWEEP Analysis

It allows to measure the frequency response with the SWEEP method (scanning frequencies over time
with sinusoidal waves). The SWEEP is a rather slow but very precise method, however, is affected by the
resonance effects of the devices under test and the environment in which the measurement is made. With
reference calibration you can get to an accuracy of a tenth of a decibel.
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The FAST-SWEEP and PULSE analysis
These methods measure the frequency response quickly and accurately. The analysis is carried out with
very short pulses that contain in equal measure all frequencies of the audio spectrum. The pulses from the
filtered in analysis components are divided in frequency and is achieved in one fell  swoop the entire
spectrum. Also, if  you start sampling immediately prior to the pulse arrival and ceases to be sampled
before they arrive unwanted signals due to reflections in the environment can be excluded resonance and
reflection phenomena.

The measurement must be carried out in a quiet environment and preferably with a microphone and a low-
noise input preamplifier, the method is sensitive to periodic disturbances (eg mains interference).

All these factors mean that noise measurement dynamic is quite limited, and that the noise tends to distort
the measurements especially in the lower part of the spectrum (below one hundred hertz).
When making measurements with FastSweep Pulse and check that the noise is enough below the curve
displayed by putting OUTPUT OFF position, otherwise raise, if possible, the output level to overcome the
background noise.  To perform measurements on speakers is  good to use a rather  powerful  external
amplifier.

To partially  overcome the abovementioned problems the DAA analyzer  provides  two  FastSweep and
Pulse optimized methods respectively for the upper and lower parts of the spectrum.

FastSweep uses a pulse that contains equal energy all frequencies and is affected by the effects of noise
especially in the lower part of the spectrum.

Pulse uses a pulse sawtooth that starts steeply up to the maximum value and then with linear trend tends
to  zero,  a  pulse  of  this  type  contains  much  more  energy  at  low  frequencies  and  this  disparity  is
compensated for  during the analysis of  the spectrum, Pulse affected by noise in the high part  of  the
spectrum.

 
The method used to perform the spectrum analysis is the FHT Fast Hartley Transform that is faster and
more accurate than FFT Fast  Fourier  Transform. All  of  fast  processing methods are inherently linear
nature and to get a logarithmic scale ranging reconverted before being displayed.

Depending on the minimum and maximum frequency analysis of the Hartley transform is performed on
1024,  2048,  4096,  8192  or  18384  samples.  If  you  select  a  minimum  frequency  below  50  Hz,  the
logarithmic scale X or X scale expanded very slightly slows down the speed of analysis.

For all types of spectrum analysis you can use the cursor Cursor 1 of the meter panel to measure with
greater accuracy.

Mixer Settings

For all the measures it is necessary that the controls BASS and TREBLE of MIXER are centrally located
and 3Dstereo that the command is enabled. If you want to use these commands (for example, to evaluate
their effectiveness) you have to keep the output volume to about twenty decibels below the maximum to
avoid that distort the sound card output.

Some distort sound cards when they work with the maximum output voltage and 'always good do not keep
up the WAVE slider output level of the mixer output. Sometimes' well even lower level of DAA OutLev one
or two decibels.
Check with a sine wave and the spectrum analyzer with the level of harmonics and spurious which should
be at least 80 decibels below the fundamental.
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The Analysis panel

With the ANALYSIS panel determines the basic configuration of the analyzer.

WAVE Oscilloscope and signal generator.

BURST Showing oscilloscope type and signal generator to BURST (pulse package) 
The number of cycles that make up the package and the pause between packets is set by 
SETTING - BURST and PAUSE. 
This type of analysis is often used to highlight the resonance due to queues insufficient 
damping of speakers.

Spectr Spectrum analysis. 
The measuring scale is adjustable with SETTINGS - FMAX, FMIN, DBMAX, DBMIN. 
The type of scale is selected by SPECTRUM XLIN/XLOG and YLIN/YLOG. 
The response speed is adjusted with SPECTRUM - Speed. 
The spectrum can also be displayed in three dimensions (amplitude, frequency and 
time) by selecting Spectrum3D from the VIEW menu.

Sweep Spectrum analysis in frequency sweep with a sinusoidal generator. 
Remember to place the ON INPUT and OUTPUT MONO position or location STEREO and 
select SINE WAVEFORM position. 
The scanning time is adjustable with SETTINGS - TIME. 
The measuring scale is adjustable with SETTINGS - FMAX, FMIN, DBMAX, DBMIN. 
The type of scale is selected by SPECTRUM XLIN/XLOG and YLIN/YLOG.

FastSweep impulsive Analysis of the frequency response optimized for maximum dynamic 
(Minimum noise) on the upper part of the spectrum. 
The measuring scale is adjustable with SETTINGS - FMAX, FMIN, DBMAX, DBMIN. 
The type of scale is selected by SPECTRUM XLIN/XLOG and YLIN/YLOG. 
The response speed is adjusted with SPECTRUM - Speed.

Pulse impulsive Analysis of the frequency response optimized for maximum dynamic 
(Minimum noise) on the lower part of the spectrum. 
The measuring scale is adjustable with SETTINGS - FMAX, FMIN, DBMAX, DBMIN. 
The type of scale is selected by SPECTRUM XLIN/XLOG and YLIN/YLOG. 
The response speed is adjusted with SPECTRUM - Speed.
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The Waveform panel

With this panel will select the waveform of the signal generator. 

SINE Sine wave.

TRIANG Triangular wave.

RAMP+ Wave positive ramp.

RAMP- Negative ramp wave.

SQUARE Square wave.

NOISE White noise.

These waveforms are obtained only if OUTPUT is ON and if ANALISIS is in position WAVE, BURST or
Spectr.

Theremino System - DAA Help - March 3, 2018 - Page 13



The Settings panel

The panel is composed of a selection keyboard and a
knob and a display to adjust and display the selected
value.

I  pressed  buttons  are  highlighted  in  orange.  Those
assets are trimmed in blue.

DISPLAY Show the selected value. 
Click on the display with the left mouse button to edit the value, then press ENTER key or 
click on the knob to confirm the value.

KNOB Regulation for all the values, this knob which acts with an effect proportional to the speed
of rotation allows rapid changes but also fine adjustments. 

FREQ Frequency of the signals generated from 1 Hz to 22 KHz.

FMAX Minimum viewing frequency from 1 Hz to 22 KHz 
(SWEEP, SPECTRUM and PULSE). FMAX can not fall below FMIN.

FMIN Maximum viewing frequency from 1 Hz to 22 KHz 
(SWEEP, SPECTRUM and PULSE) FMIN can not exceed FMAX.

DBMAX Upper limit of the scale from -90 dB to +10 dB (SPECTRUM, SWEEP and PULSE). 
Near Dbmax can not fall below DBMIN.

DBMIN Low limit of the scale from -120 dB to +10 dB (SPECTRUM, SWEEP and PULSE). 
DBMIN not exceed near Dbmax.

TIME Duration of scan in seconds (SWEEP). 
Use a long time to make more precise the lower part of the frequency spectrum.

DUTY pulse / space ratio for the square wave (SQUARE).

BURST Number of cycles that make up the pulse packet (BURST).

PAUSE Number of cycles that make the break between the pulse packets (BURST).

BEGIN Beginning of sampling (for FastSweep and Pulse only). 
This value is rather difficult to adjust (see Notes Begin - End) if you do not know how 
adjust to keep it to a minimum, ie to zero.

END End of sampling (pears only Pulse). 
This value is rather difficult to adjust (see Notes to Begin - End) if you do not know how 
adjust keep the maximum value, ie to 200mS.

OUTLEV Output level for the signal generator and for the Sweep pulses, FastSweep and Pulse. 
The usefulness of the output level is to make small precise changes to the tenth of a 
decibel They are not possible with the Windows Mixer. 
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The Spectrum panel

Scale Settings for: Sweep, Spectr, PulseLo and PulseHi.

XLIN Frequency scale (linear axis X). 

XLOG Scale frequency (X-axis) logarithmically.

YLIN Scale of the amplitudes (Y linear axis). 
The linear scale is calibrated in volts.

YLOG Scale of the amplitudes (Y axis) logarithmically. 
The logarithmic scale is calibrated in decibels (referenced to 2 volts peak-to-peak)

Speed Rapid response of the display. 
Speed adjusting to a low value (counterclockwise) is carried out the average over a long 
time improving the measuring accuracy and decreasing the noise.
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The Menu bar

The menu bar allows you to access files and to choose global features and configurations related to the 
whole application.

The last two menu items, related to audio inputs and outputs, vary depending on the sound card and 
operating system language.

On the following pages the menus are explained one by one.
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The File menu

Open Read the DAA files. 
All analyzer settings are present in the DAA files therefore you can quickly restore a 
configuration prepared and saved earlier.

Save Regulations Save the analyzer status on the currently selected DAA file. 
The current file name is visible in the title bar (top left).
If no file name is selected then a Save Dialog will ask for it.

Save Regulat. As... Save the analyzer status of a selected file or a new file.

Save Display Save the image on the display in BITMAP format.

Files List The recently used files.

Exit To exit the DAA program.

The View menu

Spectrum3D Displays the spectrum analysis in three dimensions (amplitude, frequency and time).

SetReference Freeze the shape of this waveform on the screen to use as a comparison and 
reference.

SweepMultiDraw Only it used with the SWEEP analyzes. 
Press the right mouse button to start a new sweep.
The previous sweep are not deleted. 
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The Bandwidth menu

Selects the bandwidth for SPECTRUM and PULSE analysis.

The Window menu

Selects the sampling window for SPECTRUM analysis.

The Settings menu

Audio mixers - Opens mixer listening audio (output) and record (input)

Audio devices - Opens the control panel for the audio devices 
configuration.

Register DAA files - With this command you register DAA files to open 
them with a double click with this application.

If you move the DAA application, or change its name to its folder, the operating system can no longer
associate DAA files with the application. Instead this command always succeeds.

Remember  all  props  -  Enabling  this  option  all  the  settings  are  remembered  also  by  closing  the
application.  To  restore  the  basic  settings,  deselect  this  option  and  then  close  and  restart  the  DAA
application.
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The Help menu

Help - Opens the folder containing the documentation files.

About - Provides information on the DAA program.

The Input Devices menu

With this menu you choose the input device.

The number of items that appear depends on the sound card.

Some  devices  may  not  appear  because  they  are  disabled.  With  the
AudioDevices menu you can view hidden devices and enable them.

The Output Devices menu
With this menu you choose the output device.

The number of items that appear depends on the sound card.

Some devices may not  appear  because they are disabled.  With the
AudioDevices menu you can view hidden devices and enable them.
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The Begin-End controls
By choosing a sampling window that begins when the impulse is to reach the microphone and ends before
they reach the reflections on the walls of the environment you get a higher precision for FastSweep and
Pulse analysis. These values must, however, be adjusted with otherwise cognition can completely distort
the measurement.

BEGIN

usually BEGIN and 'to zero, the automatic synchronism places the beginning of the sampling just before
the' beginning of the pulse to be analyzed. Sometimes, however, 'the synchronism does not act well and
is' necessary to make a small manual corrections by BEGIN.

If BEGIN is exceeded, even slightly, the pulse start this is truncated, and the frequency response changes
so completely an adjustment mode can be arriving until the response changes and then go back a little.

The most accurate method to adjust BEGIN however, is the following:

Press the SAMPLES button.

Set the TIME BASE knob at 1mS/Div, raise mV/Div of one up to frame good channel pulse start

Adjust BEGIN to bring the surge began about a division of the TRIGGER on the right arrow. 

Also check that the pulse width is less than one volt (see VIEW Menu - ViewSamples).

END

The END adjustment only with PULSE type analysis, 

Normally the END value is left at  maximum (200 mS) but it  is possible to decrease it  to truncate the
sampling so as to exclude reflections on the walls of the room.

Adjust END to the distance between the speaker and the nearest opposite wall or side of the chest, plus
the distance between this wall and the microphone.

If the environment is small and therefore the distance is low you lose precision on the low part of the
spectrum and it is better to adjust END on a higher value even if doing so includes a part of the reflections.

The END and 'measured in milliseconds value but while it regulates and' can see in the bottom (status
bar) the converted value in "meters traveled by the sound".

On the status it can 'bar also read the minimum valid frequency which is continuously recalculated and is
visible until the mouse cursor remains positioned on the knob. 

Theremino System - DAA Help - March 3, 2018 - Page 20



Frequency Response measurements
To perform frequency response measurements of acoustic systems (loudspeakers) is necessary to use a
microphone. The microphone must have a sufficiently flat frequency response are therefore excluded from
the dynamic microphones.

A great microphone for these measures is the electret type that is readily available commercially.

The best electret microphones ensure a frequency response within a decibel from 20 Hz to 20 KHz (do not
use models with three-wire or with an outer diameter of 10..12 mm. Using the model to two terminals with
a diameter of 6 mm).

The electret microphones need a source of direct current (5..10 volts in series with a resistor 4..10 K) that
is usually already arranged on the incoming MIC sound cards (only if the MIC input is not stereo).

To connect the electret microphones to the MIC use a stereo jack with two signal heads (right and left)
joined (one of the heads provides power and the other carries the signal), and a shielded cable, not longer
three meters, with stocking and only one signal wire. (Check on the arrivals feeding microphone, from 1 to
about 3 volts)

Using a microphone preamplifier 
If  the power supply is not available, he wanted to use a connection wire is longer or requires greater
sensitivity  you  will  have  to  use  an  external  preamplifier  with  power  stack  that  greatly  facilitate  the
measurements.

The external preamplifier advantages are:

Greater and adjustable sensitivity

Low noise and elimination of cable noises

Very low output impedance which allows to use a long cable up to 10..50 meters.

The external preamplifier must be connected to the LINE (not MIC). 

The shielded cable must stand between the preamplifier and the input LINE and not between the 
microphone and preamplifier which must instead be close, with a short and well shielded connection.

What type of preamplifier
The preamplifier without battery be enough if you work with moderate sound pressure but must be careful
because it could easily saturate (check with the "SAMPLES" button).

For professional use in all conditions it is better to use the version with battery. 

To further increase the tolerance to high sound pressures (concert plants) it is possible to increase the
battery voltage up to thirty volts, replacing C1 with a 35volt capacitor, and increase R1 up to about 39K.
Then measure the voltage on the "Test Point" and replace R1 to obtain the half of the supply voltage.
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Preamplifier with battery

Disposition of the components
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A pre-amplified microphone without battery
 
To avoid the hassle of having to periodically change the battery and also to avoid the clutter and the
mechanical complications due to the holder, there is a very convenient solution, but that is not found in
commerce. Who was able to do small works of electronics could build it. 

Features :

Gain 12 dB 
(Minimum  8,  maximum  14
depending on the sound card)

Noise of very low down 
(Indistinguishable  from  the
noise  of  the  microphone
bottom itself)

Frequency  range  from  10Hz
to 100KHz

The components are not critical, instead of BC857 you can use a BC307 or any other PNP small signal.

E 'can make a small  assembly in  the air  or  you can make a printed circuit  board with double-sided
vetronite. On the lower face, which is not 'visible here, the copper must be a continuous plane.

On the left is steady the microphone (an electret microphone 6mm) with the negative on the lower face
and the positive on the junction of the resistor and the capacitor.

 
In  this  hole  is  inserted  a  small
wire  diameter  and  is  welded
above and below.

From  here  the  shielded  cable
going  to  the  PC.  It  must  be
welded  to  the  copper  cable
sheathing on the lower face and
the central wire to the triangular
pitch.

 

(Dimensions 6 x11 mm)

If  you want  to  eliminate any possibility  of  noise  and hum and well  enclose the whole  (including the
microphone and the stripped end portion of the shielded cable) in a copper tube 6mm inner diameter, a
few centimeters long, and solder the wire to this tube and that 'soldered to the printed hole.
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Advice on the microphone positioning

Various methods are used to measure the response curve of the
boxes, without having any inaccuracies due to the reflections.

First method

Place the box outdoors, lying down with the cones pointing upwards, and the microphone hanging one
meter in height (inexpensive but also very inconvenient).

Second method

Use an anechoic chamber.

Third method ("Begin" and "End")

Begin and End can only be used if you work in a very large environment (disco) where the nearest wall is
over ten meters. 

The microphone is placed a few meters from the speaker. Only one speaker is lit at a time otherwise they
interfere with each other and ruin the measurements. "Begin" is set so as not to cut off the first part of the
"End" impulse is set to double of the distance from the nearest wall. This "double" must be at least 20..25
meters otherwise the bass is measured badly. This way the sampling window excludes the reflections
because they arrive too late and when the measure is reached now made.

Fourth method

Keep the microphone very close to the speakers, it is the most comfortable and, in some ways, even the
most accurate as long as you do a little testing so you understand well what you are measuring and do not
take dazzle.

With the microphone at 5.50 cm from the cones (depending on the size of the speakers and the room) the
difference in sound pressure between the direct and the reflected sound is so high that the reflections do
not affect almost the measurements.

With not more than 5 centimeters errors are certainly less than a decibel.

However, in doing so, you must measure the cones one at a time by placing the microphone exactly on
the axis in front of the cone (at the same distance for all the cones).

It ends up so to have three separate curves (or two or four depending on the number of ways) curves to
be evaluated separately, in order to understand the flatness and the peaks and holes of each band.

Then the microphone is moved away to a meter (on the axis - in the middle of the box) and, neglecting this
time the peaks and the holes that will surely be increased, focuses on the average level of the bands that
must be as similar as possible.

The fourth method may seem imprecise and insecure, but when you take your hand, it is the best, even
the most accurate of the anechoic chamber.

The next page explains other details of this method.
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Operation of the fourth method

  
If you place the microphone on a meter-by-case basis (classic measurement in an anechoic chamber),
you  will  find  peaks  and  holes  (especially  in  the  crossover  frequency  zones)  that  are  due  to  the
microphone-tweeter, microphone-midrange and microphone-woofer distances.

There are interferences characteristic for that particular position of the microphone that change completely
if  you move the microphone (even 5 or  10 dB for  a movement of  50 centimeters to the right or  left,
backwards or upwards, etc.)

These peaks, caused by interference, have nothing to do with the environment, reverberating or not, and
all the speakers with more than one cone, even the most expensive, even in an anechoic chamber, create
peaks and valleys at certain frequencies, that change at depending on the distance and position of the
microphone.

It is an unavoidable physical phenomenon, in some particular positions and particular frequencies the
pressures add up or cancel each other out. There is no remedy unless you have all the sources at one
point, even the cones with the coaxial tweeter are not exempt (due to those two centimeters away), you
should just use a single cone... and you can not .

Ultimately, if you try to measure the whole case you will always find peaks and valleys (even of 10 dB) that
confuse  the  measures  and  do  not  center  anything  with  the  characteristics  of  the  cones,  crates  and
crossovers.

The builders of coffers know this and always make sure to reduce as much as possible the inaccuracies
that are measured at one meter, in axis. Too bad that usually the speakers listen to more distance and
almost always off-axis.

This is not to say that at three meters the boxes will be worse, but that you should not fix yourself to
measure and correct the holes and the peaks due to interference (so each listening point will have them
different). And be careful not to lose hours with the equalizers to get a perfect equalization that will then be
valid only at the exact point where the microphone is positioned.

We could measure the answer  in,  say,  ten or  twenty different  positions  randomly spaced across the
listening area and then averaging...

But the best thing would be to have an instrument that do not see these interferences, and, indeed, this is
precisely what we get if we measure the cones one by one at a short distance and in axis.

Finally, you move the microphone at more distance. You pretend that peaks and valleys do not exist and
equalize the cones emissions by adjusting the gain of each band.
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Technical features
The DAA 5224 and 'a measuring instrument and test equipment for audio with high precision.

The instrument comprises the following functional blocks:

Signal viewer

Signal generator

Sampler

Frequency meter

Analyzer

Viewer (as oscilloscope)
- Amplitude adjustable from 1 mV / div to 1 V / div
- Time base from 100 sec/div to 100 us/div
- Trigger positive or negative
- Triggers for pulsed signals
- Level control for manual trigger
- Two tracks, addition, subtraction and display X/Y.
- A width of the track position.
- Visualization with delay and DeltaTime.
- Storage of the last ten seconds at full resolution.
- Automatic calibration of the DC offset.

Viewer (as a spectrum analyzer)
- X-axis linear or logarithmic with minimum and maximum frequency adjustment.
- Axis Y linear with maximum amplitude adjustment from 1 Veff to 1 mVeff
- Y logarimic with maximum amplitude adjustment from + 10 dB to -90 dB
- Y logarimic with minimum amplitude adjustment from 0 dB to -120 dB

Viewer (as three-dimensional spectrum analyzer)
- X axis and Y as spectrum analysis
- Z axis with time adjustment.

Signal generator
- Frequency range: 1 Hz to 22 kHz in steps of 0.1 Hz.
- Waveforms: Sine / Square / Triangular / Ramp positive / Ramp negative / White Noise / Burst / Special 
pulses for frequency response measurements.
- Adjusting the duty cycle: 10 to 90% in steps of 0.001%
- Distortion less than 0.002%
- Noise less than -96 dB
- Stability and accuracy better than +/- 0.0001 Hz and one part in 200,000, equal to 0.0005%

Sampler
- Frequency range: 0.1 Hz to 22 Khz
- Noise less than -96 dB

Frequency Meter
- Measurement of frequencies from 0.1 Hz to 22 Khz with an accuracy of 0.001 Hz.
- Measures of time from 1 second to 100 us with precision 50uS

Analyzer
- Measurements of amplitude in dB and in volts.
- Measurements of timing and frequency offsets.
- Sliders measurement.
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Frequency Precision characteristics
With a good sound card the accuracy of measurements of time and frequency is better than one part in a
million.

Some sound cards,  in particular conditions, can be very inaccurate in the sampling frequency. So it is
good to check your card with a known precise source (not the 50Hz).

Note  also  that  if  the  sound  card  is  used  simultaneously  by  the  DAA and  one  or  more  other  audio
applications the frequency accuracy can, in some cases, deteriorate considerably. 

In  the  event  that  two  applications  use  different  sample  rates  some  sound  card  privilege  the  first
application, and perform subsequent applications with an approximate sampling rate (in some cases even
errors of one percent).

Other characteristics

Some sound cards have an artificial system enlargement of the distance between the speakers (3d stereo
enhancement), make sure it is disabled otherwise the frequency response is disturbed.

Also make sure that the tone controls are inactive.

Some notebooks have an ever-present equalizer to enhance the sound of their small speakers, often, but
not always, you get a flat response when you insert a jack on the audio output. Sometimes it can 'be
necessary to power cycle the audio out' cause the jack is detected.

Depending on the used sound card, and as it is physically installed in the computer and of the shielding
characteristics of the computer, noises may be present noise components outside the audio range (50 Khz
- 200 Mhz) also of considerable amplitude.

These noises, which usually do not cause problems in audio measurements, could be eliminated using
connection cables that incorporate a low-pass filter.

How to see the output signal
In rare cases this may 'happen that the audio card might not support the possibility to set as input the
output signal generated by herself. 

In these cases, you must put a wire (stereo jack) between the output "LINE OUT" and the "LINE IN input"
or "MIC IN".

On notebooks it is always good to put a jack in "LINE OUT" so that the sound card excludes the internal
speakers, so the internal equalizer which serves to make them sound a bit better, thus obtaining a flat
frequency response that is important for the measurements.
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